
 
 

NIST Special Publication 1200-22 
 
 

Challenges and approaches for 
particle size analysis on micrographs 

of nanoparticles loaded onto textile 
surfaces 

 
Version 1.0 

 
  

Samuel J. Underwood 
Justin M. Gorham 

 
This publication is available free of charge from: 

https://doi.org/10.6028/NIST.SP.1200-22 
 
 
 
 
 
 
 

 
 
 
 



NIST Special Publication 1200-22 

Challenges and approaches for 
particle size analysis on micrographs 

of nanoparticles loaded onto textile 
surfaces 

Version 1.0 

Samuel J. Underwood 
Justin M. Gorham 

Materials Measurement Science Division 
Materials Measurement Laboratory 

Samuel J. Underwood 
Department of Chemistry 

University of Oregon 

This publication is available free of charge from: 
https://doi.org/10.6028/NIST.SP.1200-22 

May 2017 

U.S. Department of Commerce 
Wilbur L. Ross, Jr., Secretary 

National Institute of Standards and Technology 
Kent Rochford, Acting NIST Director and Under Secretary of Commerce for Standards and Technology  



Certain commercial entities, equipment, or materials may be identified in this 
 document in order to describe an experimental procedure or concept adequately. 

Such identification is not intended to imply recommendation or endorsement by the 
National Institute of Standards and Technology, nor is it intended to imply that the 
entities, materials, or equipment are necessarily the best available for the purpose. 

National Institute of Standards and Technology Special Publication 1200-22 
Natl. Inst. Stand. Technol. Spec. Publ. 1200-22, 18 pages (May 2017) 

CODEN: NSPUE2 

This publication is available free of charge from: https://doi.org/10.6028/NIST.SP.1200-22

Please direct all communication regarding this publication to the corresponding author: 
Justin M. Gorham (justin.gorham@nist.gov) 

mailto:justin.gorham@nist.gov


 
 

i 

 

FOREWORD 
 
This National Institute of Standards and Technology (NIST) Special Publication (SP) is one in a 
series of NIST SPs that address research needs articulated in the National Nanotechnology 
Initiative (NNI) Environmental, Health, and Safety Research Strategy published in 20112. This 
Strategy identified a Nanomaterial Measurement Infrastructure (NMI) as essential for science-
based risk assessment and risk management of nanotechnology-enabled products as pertaining to 
human health, exposure, and the environment.  NIST was identified as the lead federal agency in 
the NMI core research area of the Strategy. This research area includes development of 
measurement tools for the detection and characterization of engineered nanomaterials in 
nanotechnology-enabled products. Textiles containing silver nanoparticles are consumer products 
of great interest for nanotechnology environmental, health, and safety (nano-EHS) research and 
for product regulation.  Detection and characterization of these nanomaterials is a focus of this SP. 
 
The protocol in this SP describes challenges and approaches for acquiring and analyzing 
microscope images of nanoparticles to obtain particle size distributions. An example methodology 
is also proposed, which is designed to be high throughput and internally consistent while limiting 
the number of subjective choices.  While this protocol was developed with the silver nanoparticle-
loaded textile samples in mind, the strategies described herein could be applied to particles of any 
size, and the required micrographs could be gathered via scanning electron microscopy (SEM), 
transmission electron microscopy (TEM), light microscopy, or other image-based techniques.  
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1 Introduction 
 
This special publication is the result of an effort to develop high-throughput image acquisition and 
analysis protocol capable of reproducibly characterizing the distribution of silver nanoparticles 
(AgNP) on a textile by electron microscopy.  This is in follow-up to a previous study, which 
developed a protocol for making silver nanoparticle-loaded textile test materials to be used for 
measurement validation3. Ultimately, this goal is best accomplished by modifying the surface of a 
nano-enabled textile sample, taking tens or hundreds of micrographs, and subjecting them to 
automated particle-sizing software routines. The method in this document relies on free open-
source image processing package Fiji (Fiji Is Just ImageJ)4.   
 
Fiji is an open source distribution of ImageJ, developed by the National Institutes of Health (NIH) 
(Bethesda, MD) 4-5 and can be downloaded from http://imagej.net/Fiji. The procedure outlined 
herein uses Fiji to organize, process and analyze 8-bit images in TIFF format to calculate pixel 
area values for regions of interest defined by intensity thresholding after performing functions 
including noise correction, contrast manipulation, and spatial calibration to furnish digital images 
with a physical measurement scale.  It is important to note that this is intended to be a guide towards 
developing streamlined image analysis approaches for a given sample set, and the settings 
employed for the AgNP example may not work for other examples which employ different 
samples, substrates and equipment. 
 
2 Materials 
 
The AgNP-loaded textiles in this study were prepared by a modified version of a previous study 3, 

6. Briefly, Ag+ was reduced in the presence of cotton threads at elevated temperatures to generate 
30 nm to 50 nm AgNPs, in-situ. For this special publication, cotton fabric was used to prepare 
samples. A vial of RM 8017, the 75 nm AgNP reference material stabilized by polyvinyl 
pyrrolidone, was also used to prepare control samples. 
 
3 Collecting Images for Particle Size Analysis 

 
3.1 Image acquisition 
The micrographs were collected with an FEI Quanta 200 field-emission environmental scanning 
electron microscope (E-SEM) operating in high-vacuum mode. Most images had a horizontal field 
width (HFW) of 3.2 micrometers and a horizontal resolution of 2048 pixels (px). Prior to imaging, 
samples were affixed to aluminum stubs using carbon tape, then coated with carbon in a 
Cressington 208 Carbon Coater using high-purity graphite rods.  Images were acquired using a 
secondary electron detector at a working distance of 10.2 mm with a nominal electron beam spot 
size setting in the software of 3.0 or 3.5 and using an accelerating voltage of 5 kV or 10 kV, 
respectively.  While it is not possible to quote the exact size of the electron beam employed since 
we did not measure appropriate controls using these settings, the FEI provided values diameters 
using comparable conditions allowing us to estimate values of 2.1 nm and <3.4 nm, respectively. 
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3.2 Challenges 
There are inevitable challenges in acquiring representative sets of images on the varying surface 
of the AgNP-loaded textile, as well as in efficiently and effectively obtaining meaningful size 
distributions.  The following three topics were found to be the primary problems in SEM image 
acquisition while the fourth also pertains to image analysis. 
 

3.2.1 Charging and distortion 
Sample charging was found to cause several artifacts including distortions and/or obscuring 
sample features due to the insulating textile background which was not always sufficiently 
conductive even with large surface loadings of AgNP or carbon coating.  The second problem 
is that higher resolution imaging exhibits more charging due to the increased flux of electrons.  
An example of the charging is shown in Figure 1 (a).  This charging is a problem, especially 
for sizing, since even a small amount of distortion will influence the accuracy of any particle 
size measurement.  Charging can be compensated—to an extent—by modifying the surface 
with a conductive coating (as was done in this project) and/or by choosing optimal electron 
beam parameters.  However, the conductive coating adds an unknown (small) amount of 
material to the particles and changes their size. 

 
3.2.2 Variable background 
Non-flat image backgrounds may occur from surface topography and charging inhomogeneity, 
which appear as bright (high secondary electron intensity) features resembling points and steps 
on micrographs (See Figure 1(b)).  These features, sometimes refered to as edge effects, are 
problematic when trying to perform automated particle size analysis, as they may 1) overlap 
with existing particles, 2) be incorrectly identified as particles, 3) increase particle size or 4) 
completely obscure relevant features.  Macros/scripts can be used to compensate to an extent 
for these features, and will be discussed in Section 4.  However, some degree of undercounting 
may occur when applying macros/scripts to compensate for varying background. 

 
3.2.3 Agglomerates and aggregates 
Aggregates and agglomerates, as can be observed in Figure 1(c), are also found on textiles 
loaded with AgNP and are an interesting addition to the surface morphology. Aggregates are 
generally assumed to be related to the preparation of the textile.  However, they do not reflect 
individual nanoparticles and if one is trying to determine the particle diameter of individual 

(a) (b) (c) 

Figure 1:  Examples of SEM imaging artifacts observed during the analysis of AgNP-loaded 
textiles. These include (a) charging, (b) edge/background effects, and (c) agglomerates and 
aggregates. 
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AgNPs, aggregates must not be measured.  Macros/scripts can be used to compensate for these 
features as will be discussed in Section 4 and in the appendix, with a focus of how to exclude 
aggregates in the single particle size distribution determination.   

 
3.2.4 Efficiency versus control 
While efficiency and control are not always problems related to image acquisition or 
processing, these issues can be at odds when trying to ensure that measured distributions of 
particle sizes are quantifiably reproducibly.  With respect to image analysis, two extreme 
approaches could be employed to estimate the particle size: 1) use a software package to 
manually measure each individual particle by, for example, drawing a line across each 
individual particle (control is maximized here) and 2) use a software package which allows for 
fully automatic measurement of all particle sizes (efficiency is maximized here).   
 
There are pros and cons to each approach.  For example, a fully manual measurement allows 
the user to have increased certainty that all measurements are of the particle in question for a 
handful of particles.  However, by using a manual approach, it could take days to obtain a 
reasonable number of measurements (100’s or 1000’s), and there could be day-to-day 
variations in how the measurements are made due to small subjective user choices and user 
fatigue.  In contrast, a fully automated approach typically requires the input of a set of 
parameters that the software then employs to automatically screen out artifacts and take a 
measurement of particles based on segmentation of each image.  Thus, a fully automated 
approach can result in an entire image of particles sized in a matter of minutes, quickly yielding 
results that are consistent.  However, depending on the sample and the imaging conditions, this 
approach could omit particles that should be included, include artifacts that should not be 
included, and incorrectly identify particle boundaries because of subjective choices in the 
coding/script commands.      
 
In this SP, we present an approach using a combination of automated processing with manual 
screening, allowing for user evaluation of the particle boundaries and imaging artifacts 
(control) while still quickly automating many of the processing decisions into a ‘one click’ 
approach (efficiency and consistency). 

 
3.3 Image requirements  
Images best-suited for processing in the manner detailed in section 4 have a high concentration of 
bright, non-overlapping particles that stand out well against a dark background.  Dark particles on 
a white background (as from a TEM image) are also acceptable.  Images unsuitable for analysis 
exhibit: significant overlap of particles, poorly-defined particle edges, substantial background 
features, low contrast, distortion due to charging effects, astigmatism, excessive noise, or low 
resolution. Extensive background features can be removed to some extent during processing; 
however, we recommend capturing the cleanest images possible to minimize the impact of 
processing. 
 
For the most effective use of processing with Fiji and macros, it is important to ensure that all 
imaging conditions are constant.  In the authors opinion, once unsuitable images are screened out 
the most important variables to be kept constant are image size, pixel density, and beam conditions 
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(e.g., current and voltage).  Keeping these variables constant ensures measurements all have the 
same error and limits with respect to the size range studied. 
 
Lastly, the image analysis method in the following section is useful to generate particle size 
distributions for multiple specimens with which one can find relative changes.  If a true measure 
of the size is desired, a size calibration would be required using either a NIST or a commercial 
standard.  This calibration control would need to consider the background/substrate (e.g., textiles 
are highly rough in this case) employed for the actual sample to be relevant. 
 
4 Using Fiji to Develop and Run Customized Macros for Image Processing and 

Particle Size Analysis 
 

Macros are especially well-suited to speeding up repetitive processes in Fiji, and they can call 
predefined functions to implement a variety of different actions with just a few lines of user-written 
script.  Fiji also includes a Macro Recorder, which records user actions for easy creation of 
macros7.  Additionally, the Fiji Macro Language Programmer’s Guide is a resource for the Fiji 
scripting language7. Macros are saved as text files and added to Fiji in two ways: first, by installing 
the macro manually and, second, by adding the new script to the already existing Startup Macro.  
An overall example of the macro used in this SP is available in Appendix A1 as well as much more 
detailed explanation of each individual step.   
 
4.1 Suggested processing to be included in a macro 
There are many processing steps and other techniques that can be used to improve image quality 
and allow the software to better assess sizes automatically.  However, it is crucial that all steps 
used to process the raw images are recorded and the original raw images remain intact.  This way, 
there is not loss of information, sometimes referred to as metadata, that is included by the 
manufacturers software on the image file.  Some of the steps may be added to an image analysis 
scripts and some must be performed by the analyst.  These steps can be separated into categories 
including image organization, image processing, image segmentation, and particle analysis. 
 
Image organization 

- Create a working copy of the original raw images.  Store the original image set and perform 
all subsequent image processing on the working copy.  Sometimes it is ideal to create a 
new folder for the processed images 

- The first step is to define the image size, both physically and the number of pixels so, that 
the particles observed can be measured well.  This is a step can easily be added into the 
script if one knows the horizontal field width (HFW), as is shown in Appendix A1.2.   

- Image cropping (Appendix A1.3) is necessary to remove the metadata (bottom Figure 
2(a)), since the software does not differentiate among image pixels and text pixels.  A script 
can be modified to tune the cropping macro to one’s specific images.  NOTE:  Do not save 
over the raw data file after this point or you will lose the cropped metadata permanently. 

Image processing 
- Apply noise and several smoothing filters (Appendix A1.4).  This will help to eliminate 

artifacts such as pixel noise from being reported as individual particle events. 
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- Background subtraction can address noise that was not already corrected, as well as some 
other background unevenness such as edge effects that are present because of the substrate 
and not the particles.  This is automatically done in the script shown in Appendix A1.  The 
image in Figure 2(b) is a good example of how an image can be modified by following the 
steps to this point that we have outlined. 

- The brightness and contrast adjustment is useful to maximize the dynamic range of pixel 
intensity on the greyscale (Figure 2(c)) for ease of viewing.  Pixels can have a range from 
0 to 255.  In our script (Appendix A1.5), a dialog box automatically opens with the range 
adjusted. The process then automatically pauses until the user reviews, corrects and/or 
approves the dynamic range chosen. 

Image segmentation 
- Thresholding is one of the last steps and is used to segment the image and to make a binary 

mask with each pixel identified as either a 1 or a 0, particle or background.  A greyscale 
intensity cutoff is assigned to generate this binary mask which can be automatically 

Figure 2:  Demonstration of the evolution of the image during image processing.  (a) Original 
image saved from the microscope (b) Image after cropping out  metadata, scaling, noise removal 
and background subtraction (c) image after contrast adjustments and ready for thresholding to 
generate a mask, and (d) particles are identified that are consistent with the size and shape 
constraints that are set. 

(a) (b) 

(c) (d) 
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determined by Fiji or determined by the analyst.  For our script, we have chosen to include 
user input by automatically thresholding but requiring approval or modification before 
proceeding (Appendix A1.5)8. 

Particle analysis 
- Circularity is a value used to screen the particles that would otherwise be counted for 

abnormal shapes and aggregates.  This is calculated for each particle automatically based 
on an adjusted ratio of the area: perimeter2 that is set between 0 and 1, with 1 being a perfect 
circle (Appendix A1.6).  User input is required to set the circularity in the script that we 
have written in Appendix 1. 

- A size minimum allows the removal of noise that was not accounted for in earlier steps.  In 
our script, user input is required to set the size minimum.   

- Particles on the edge of the image should not be included because their size is unknown.  
We have included this automatically in our script. 

- The final step is to calculate the size of the particles.  Fiji defaults to area of the particle 
and provides a spreadsheet/table of areas for each particle based on specifications set in 
‘Image organization’.  Additionally, a series of outlines are also provided in our script (See 
Figure 2(d)) which are representative of the particles provided in the spreadsheet that have 
met the user defined circularity and size requirements.  This outline is important to screen 
out non-particles (section 4.3). 

 
The utility of this method, especially in scenarios with more than one specimen, will greatly 
depend upon the quality and consistency of the correction of the noise and segmentation of the 
image.  This is because small variations between images can result in large size changes, especially 

Figure 3:  Impact of small changes in processing on average particle diameter.  (A) Small 
section (1 µm x 1 µm) of Figure 2 and representative mask of outline of pixels for 
acceptable particles.  (B) The impact of changing the threshold step on particle diameter 
by plotting the RSD as a function of average particle diameter with pixel boundaries by 7 
different sequential set points.   
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close to the lower limit of particle 
size determined by the minimum 
number of pixels required.  Figure 
3 demonstrates variations due to the 
cutoff points when segmenting a 
small section of the image in Figure 
2d.  It is apparent from Figure 3(A) 
that not all particles from the image 
(top) are analyzed for size which is 
indicated in the bottom image, a 
demonstration of the ability to 
screen out aggregates and small 
particles.  However, if one varies 
the threshold cutoff, the calculated 
particle diameter may change as 
well.  Figure 3(B) illustrates this by 
plotting the relative standard 
deviation (RSD) as a function of the 
average calculated particle 
diameter for a given particle at 7 
consecutive thresholding values 
(>40 particles are present at all 
threshold values).  Unsurprisingly, 
the RSD increases more for smaller 

particle diameters since comparable changes in absolute pixel count has a relatively greater impact 
on smaller particles. 
 
4.2 Sources of variability 
The user should be aware that there are several points where measurement uncertainty can arise 
and work to minimize it.  As mentioned in the previous section, consistent criteria for assignment 
of the contrast and the threshold are essential to obtaining sizes across different images that can 
reliably be compared to one another.  Other sources of uncertainty are the HFW, or imaging size, 
and the pixel density set for the samples characterized.  Both relate to the minimum particle size 
based on the pixel limits set that can be resolved.  If images used are acquired under different 
HFWs or pixel densities, the results may be skewed to average particle diameters of a smaller 
value.  
 
4.3 User input to eliminate particles that are not screened out by the macro 
While in an ideal case a one click/one command prompt would produce useable results from raw 
micrographs that have zero flows, it is not a realistic expectation.  The heterogeneous nature of the 
textile surface, requires different corrections in each image.  Furthermore, there is the possibility 
for adjoining particles (see Figure 4) and aggregates not to be screened out with the processing, so 
one must review and remove particles that are not reflective of the desired measurement.   It is 
essential that the criteria for removing a particle is kept consistent. 

 
  

(a) 

(b) 

Figure 4: (a) Section of the image from Figure 2(a) prior to 
processing.  Arrows indicate adjoining particles which are 
included as single particles in (b) which represents the particle 
included with a 0.75 circularity minimum. 
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4.4 Calculating particle diameter and generating a histogram 
Upon completion of the particle analysis 
in section 4.1, a spreadsheet including a 
list of particle areas are provided based 
on the size minimum and circularity 
limits set.  From this list, the user can 
calculate a diameter (d) based on the 
measured area (A) from the spreadsheet 
reflective of a circle of equivalent area, 
no matter what shape it appears on the 
micrograph using the following equation: 

 

 𝑑𝑑 = 2�A 𝜋𝜋�  
 
Always double-check that Fiji has 
printed the results table in the units 
appropriate.  Figure 5 is a histogram 

representative of the distribution of particles from the image in Figure 2(c) using a 5-pixel radius 
minimum size and a value of 0.85 for the circularity.  The average particle diameter was 43.5 nm 
± 13.9 nm.  Due to the low number of particles analyzed, this histogram is merely meant as a tool 
for illustration and not necessarily an accurate reflection of the sample.  It is important to note that 
with a 5-pixel minimum, there will be a 15.6 nm cutoff on particle diameter for the image size and 
pixel density.  For measurements of small-size particles represented by only a few pixels, higher 
resolution imaging may be required.  

 
5 Control to Check Particle Analysis Procedure:  RM 8017- 75 nm AgNPs 
 
To demonstrate the effectiveness of the use of the approach in section 4 using Fiji, a control was 
devised using the 75 nm silver nanoparticle reference material (RM 8017) 1.  While this control 
does not include a substrate with comparable properties to the cotton fibers (e.g., roughness, 
charging), it does benefit from having known values for size attributed to the actual material that 
we are characterizing, which is important when assessing the technique for viability.   
 
5.1 Experimental details 
RM 8017 was reconstituted in accordance to instructions in the certificate and drop-cast onto a 
Nanoplus TEM grid from Dune Scientific 1. Secondary electron micrographs were collected with 
an FEI Quanta 200 field-emission environmental scanning electron microscope (E-SEM) 
operating in high-vacuum mode, with a working distance of 10.2 mm, a spot size of 2.5 nm, and 
an accelerating voltage of 10 kV. Magnification was set to produce images with a horizontal field 
width of 3.20 µm and a horizontal resolution of 2048 pixels.  
 

Figure 5:  Histogram of particles in the image of Figure 
2(a) after processing with the macro in Appendix A1. 
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5.2 Image processing in Fiji 
Micrographs acquired, such as the one shown in Figure 6(a), were subjected to processing in Fiji 
outlined in section 4.1 and further explained in appendix A1. 

1. Crop: The data bar at the bottom of micrographs was removed. 
2. Using the macros discussed in section 4.1, a rolling ball background subtraction 
was applied with a ball radius of 40 pixels, a smooth function was applied five times, 
and a despeckle function was applied once. 
3.  In this case, the threshold was manually adjusted to ensure the whole particle was 
accounted for in the analysis. 
4. Maps were created for visual inspection and false positives (aggregates and 
artifacts) were removed. 

5. The resulting data is plotted in a histogram in 
Figure 6(b) and a list of values extracted from this 
processing are in Table 1. 
 
Table 1 presents some of the results obtained from 
the measurements of this sample.  The top three 
values are likely the key pieces of information from 
the 13 images processed, segmented and analyzed.  
The average and standard deviation allows for a 
rough comparison with the established TEM 
reference values. The 73.9 nm circular equivalent 
measurement result by the SEM, obtained from a 
much smaller number of particles, is indeed well 
within the error associated with TEM.  The reason 

Figure 6: (a) Representative images of RM 8017, nominally 75 nm silver nanoparticle reference material 
before image processing.  (b) Histogram of particle count vs. diameter over the range of particles measured 
and presented in Table 1.  A total of 290 particles were counted from 13 total images. 

(a) (b) 

Table 1: Values and statistics from the particle 
size analysis in FIJI from images of RM 8017 
silver nanoparticles based on 13 images.  For 
comparison, TEM reference values from the 
RM 8017 certificate are provided1. 
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why the uncertainty is higher for the SEM measurement is the small number of particles measured 
and that the TEM value represents the average and standard deviation of 9 separate vial of RM 
8017 (the average or the averages).1 Regardless, while one could obtain better statistics by 
measuring more particles, this still provides another good demonstration on how high through-put 
processing using macros in Fiji can be employed to analyze particles from a set of images.  

6 Abbreviations 
 
AgNP – Silver nanoparticles 
e-SEM – Environmental SEM 
Fiji – Fiji is just ImageJ 
HFW – Horizontal Field Width 
Nano-EHS – Environmental, health, and safety research as it pertains to nanomaterials 
NIH – National Institute of Health 
NIST – National Institute of Standards and Technology 
NNI – National Nanotechnology Initiative 
RM – Reference Material 
RSD – Relative Standard Deviation 
SEM - Scanning electron microscopy 
TEM - Transmission electron microscopy 
XPS – X-ray photoelectron spectroscopy 
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Appendix A1 
The text file available from https://doi.org/10.6028/nist.sp.1200-22s is an example of a macro used 
in this SP for demonstration purposes.  It is important to note that much of the choices made for 
image processing here shall be modified to fit the task at hand. 
 
 
A1.1 Commenting the script and defining a macro 
The authors consider it good practice to comment, or annotate, the script that one writes into the 
text file so future readers can understand what sections of the script are responsible for which 
actions.  For Fiji, addition of a line for a comment requires the addition of “//” symbols before the 
text describing the action.  This is required for each line. 
 
Note that a script is started and finished using the following symbols: { and }, respectively.  Each 
macro is started by identifying the title of the macro and a hotkey associated with launching the 
macro once it is loaded into Fiji.  Macros can also be launched under the “Macros” in the “Plugins” 
menu.   
 
A1.2 Scale calibration 

At some point during particle sizing, a user must calibrate the scale, 
so that the values associated with particles from the processed images 
can be converted from pixel areas to areas in square nanometers. A 
quick scale macro can be used to speed up the “set scale” process. 
This is shown in step 2 of our macro, which automatically calibrates 
the image with a user-input horizontal field width (HFW) and 
extracted horizontal pixel count.  Figure A1 shows the custom macro 
being used to calibrate an image to 3200 nm. For high accuracy work 
pertinent ISO or other traceable scale calibration methods shall be 
used.  
 
A1.3 Automatic cropping of images  
Electron micrographs will often have metadata printed at the bottom 
of the image. While this data bar is useful because it contains useful 
information, the data bar must be removed prior to particle analysis. 

A “crop” macro can be installed to speed up the process of removing the data bar, such as that seen 
in step 3 of the main text 
 
The current script for the crop macro reduces the image to 2048 pixels * 1765 pixels (3200 nm x 
2757.8 nm), removing the data bar from the bottom of the image as seen in Figure A2 (center).  
While this macro is sufficient to remove the metadata that our SEM software attaches to the bottom 
of our images, this will vary from instrument to instrument. To find the correct size for your 
instrument, the authors recommend selecting the menu command “Plugins->Macros->Record…”, 
then selecting the desired area (without the data bar) using the rectangular area selection tool. The 
Recorder should display “makeRectangle(0, 0, x, y);”.  The user should use this line 
of script to replace/correct the first line in Step 3 and save the file for future use.  The crop function 
can also manually be performed under the “Image” menu of Fiji. 
 

Figure A1:  Demonstration of 
how the information on the 
resolution line for an image 
should change when the scale 
is calibrated. 
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A1.4 Correcting noise, smoothing and background subtraction 
Fiji has built-in tools to remove unevenness using a “rolling ball” background subtraction method 
with a ball radius of, for example, 40 px.  Additionally, Fiji has tools for removing salt and pepper 
noise called “Despeckling” and  edge jaggedness using a smoothing process5.  These tools can be 
used manually and are found under the “Process” menu.  Experimentation to determine the most 
appropriate set of settings is indispensable, as these vary case by case. 
 
A1.5 Brightness/ contrast and thresholding  
To perform automatic particle analysis (to find particle size), a binary image is needed, in which 
each pixel is either black or white9. Set a threshold only after processing the image so that particles 
show clearly against the background.  Setting a threshold can be done manually.  To do so, select 
“Image->Adjust->Threshold…” (Ctrl+Shift+T). Drag the sliders until all particles are filled with 
red, out to their edges. Figure A2 shows an image that is actively where a threshold is about to be 
applied.  As can be observed, a grayscale histogram is displayed, and the user drags sliders to 
choose a threshold. Pixels shaded red will be converted to white (255), while pixels outside the 
red sections will be converted to black (0). This is a necessary step for particle analysis. For black 
particles on a white background, deselect the “Dark background” box. 
A1.6  Analyzing particles 
Fiji’s Analyze Particles function uses the binary image created in the last step to generate a list of 
particle areas. Select the menu command “Analyze->Analyze Particles…” 
Analyze Particles has two important parameters: 
 

A1.6.1 Size 
Size dictates the minimum particle size (area) that 
will be picked for analysis. A size no less than 78.5 
pixel2 was used, dictated by the 2048 pixel image 
resolution. Size minimum and maximum can help in 
excluding artifacts, agglomerates and particles that 
differ in size from those particles of interest. 
 
A1.6.2 Circularity 
Circularity is calculated as 4𝜋𝜋 ∙ A

P2
 , where A is the 

area of the analyzed particle, and P its perimeter. A 
circularity value of 1 is a perfect circle.  

 
A1.6.3 Other settings 
The Analyze Particles function calculates the area of a particle by counting the pixels 
inside a section defined by a threshold, then applies the user-defined scalar to convert 
the pixel measurement into a spatial measurement. 
Tick both “Display results” and “Clear results”. This will print a list of particle areas 
and indices, and will clear and previous measurements. “Exclude on edges” is also 
recommended, as it excludes particles that are partially cut off by the edge of the 
micrograph.  

 
A1.6.4 Analysis results 

Figure A2: Setting a Threshold by Hand 
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Fiji will display a spreadsheet of values representative of particles in a micrograph that 
meet the circularity and size minimum requirements. It is recommended to save the 
spreadsheet either by copying it into a program such as Excel, or by saving it from the 
file menu as a text file.  
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FOREWORD



This National Institute of Standards and Technology (NIST) Special Publication (SP) is one in a series of NIST SPs that address research needs articulated in the National Nanotechnology Initiative (NNI) Environmental, Health, and Safety Research Strategy published in 20112. This Strategy identified a Nanomaterial Measurement Infrastructure (NMI) as essential for science-based risk assessment and risk management of nanotechnology-enabled products as pertaining to human health, exposure, and the environment.  NIST was identified as the lead federal agency in the NMI core research area of the Strategy. This research area includes development of measurement tools for the detection and characterization of engineered nanomaterials in nanotechnology-enabled products. Textiles containing silver nanoparticles are consumer products of great interest for nanotechnology environmental, health, and safety (nano-EHS) research and for product regulation.  Detection and characterization of these nanomaterials is a focus of this SP.



The protocol in this SP describes challenges and approaches for acquiring and analyzing microscope images of nanoparticles to obtain particle size distributions. An example methodology is also proposed, which is designed to be high throughput and internally consistent while limiting the number of subjective choices.  While this protocol was developed with the silver nanoparticle-loaded textile samples in mind, the strategies described herein could be applied to particles of any size, and the required micrographs could be gathered via scanning electron microscopy (SEM), transmission electron microscopy (TEM), light microscopy, or other image-based techniques. 





i

1 Introduction



This special publication is the result of an effort to develop high-throughput image acquisition and analysis protocol capable of reproducibly characterizing the distribution of silver nanoparticles (AgNP) on a textile by electron microscopy.  This is in follow-up to a previous study, which developed a protocol for making silver nanoparticle-loaded textile test materials to be used for measurement validation3. Ultimately, this goal is best accomplished by modifying the surface of a nano-enabled textile sample, taking tens or hundreds of micrographs, and subjecting them to automated particle-sizing software routines. The method in this document relies on free open-source image processing package Fiji (Fiji Is Just ImageJ)4.  



Fiji is an open source distribution of ImageJ, developed by the National Institutes of Health (NIH) (Bethesda, MD) 4-5 and can be downloaded from http://imagej.net/Fiji. The procedure outlined herein uses Fiji to organize, process and analyze 8-bit images in TIFF format to calculate pixel area values for regions of interest defined by intensity thresholding after performing functions including noise correction, contrast manipulation, and spatial calibration to furnish digital images with a physical measurement scale.  It is important to note that this is intended to be a guide towards developing streamlined image analysis approaches for a given sample set, and the settings employed for the AgNP example may not work for other examples which employ different samples, substrates and equipment.



2 Materials



The AgNP-loaded textiles in this study were prepared by a modified version of a previous study 3, 6. Briefly, Ag+ was reduced in the presence of cotton threads at elevated temperatures to generate 30 nm to 50 nm AgNPs, in-situ. For this special publication, cotton fabric was used to prepare samples. A vial of RM 8017, the 75 nm AgNP reference material stabilized by polyvinyl pyrrolidone, was also used to prepare control samples.



3 Collecting Images for Particle Size Analysis



3.1 Image acquisition

The micrographs were collected with an FEI Quanta 200 field-emission environmental scanning electron microscope (E-SEM) operating in high-vacuum mode. Most images had a horizontal field width (HFW) of 3.2 micrometers and a horizontal resolution of 2048 pixels (px). Prior to imaging, samples were affixed to aluminum stubs using carbon tape, then coated with carbon in a Cressington 208 Carbon Coater using high-purity graphite rods.  Images were acquired using a secondary electron detector at a working distance of 10.2 mm with a nominal electron beam spot size setting in the software of 3.0 or 3.5 and using an accelerating voltage of 5 kV or 10 kV, respectively.  While it is not possible to quote the exact size of the electron beam employed since we did not measure appropriate controls using these settings, the FEI provided values diameters using comparable conditions allowing us to estimate values of 2.1 nm and <3.4 nm, respectively.





3.2 Challenges(a)

(b)

(c)

Figure 1:  Examples of SEM imaging artifacts observed during the analysis of AgNP-loaded textiles. These include (a) charging, (b) edge/background effects, and (c) agglomerates and aggregates.



There are inevitable challenges in acquiring representative sets of images on the varying surface of the AgNP-loaded textile, as well as in efficiently and effectively obtaining meaningful size distributions.  The following three topics were found to be the primary problems in SEM image acquisition while the fourth also pertains to image analysis.



3.2.1 Charging and distortion

Sample charging was found to cause several artifacts including distortions and/or obscuring sample features due to the insulating textile background which was not always sufficiently conductive even with large surface loadings of AgNP or carbon coating.  The second problem is that higher resolution imaging exhibits more charging due to the increased flux of electrons.  An example of the charging is shown in Figure 1 (a).  This charging is a problem, especially for sizing, since even a small amount of distortion will influence the accuracy of any particle size measurement.  Charging can be compensated—to an extent—by modifying the surface with a conductive coating (as was done in this project) and/or by choosing optimal electron beam parameters.  However, the conductive coating adds an unknown (small) amount of material to the particles and changes their size.



3.2.2 Variable background

Non-flat image backgrounds may occur from surface topography and charging inhomogeneity, which appear as bright (high secondary electron intensity) features resembling points and steps on micrographs (See Figure 1(b)).  These features, sometimes refered to as edge effects, are problematic when trying to perform automated particle size analysis, as they may 1) overlap with existing particles, 2) be incorrectly identified as particles, 3) increase particle size or 4) completely obscure relevant features.  Macros/scripts can be used to compensate to an extent for these features, and will be discussed in Section 4.  However, some degree of undercounting may occur when applying macros/scripts to compensate for varying background.



3.2.3 Agglomerates and aggregates

Aggregates and agglomerates, as can be observed in Figure 1(c), are also found on textiles loaded with AgNP and are an interesting addition to the surface morphology. Aggregates are generally assumed to be related to the preparation of the textile.  However, they do not reflect individual nanoparticles and if one is trying to determine the particle diameter of individual AgNPs, aggregates must not be measured.  Macros/scripts can be used to compensate for these features as will be discussed in Section 4 and in the appendix, with a focus of how to exclude aggregates in the single particle size distribution determination.  



3.2.4 Efficiency versus control

While efficiency and control are not always problems related to image acquisition or processing, these issues can be at odds when trying to ensure that measured distributions of particle sizes are quantifiably reproducibly.  With respect to image analysis, two extreme approaches could be employed to estimate the particle size: 1) use a software package to manually measure each individual particle by, for example, drawing a line across each individual particle (control is maximized here) and 2) use a software package which allows for fully automatic measurement of all particle sizes (efficiency is maximized here).  



There are pros and cons to each approach.  For example, a fully manual measurement allows the user to have increased certainty that all measurements are of the particle in question for a handful of particles.  However, by using a manual approach, it could take days to obtain a reasonable number of measurements (100’s or 1000’s), and there could be day-to-day variations in how the measurements are made due to small subjective user choices and user fatigue.  In contrast, a fully automated approach typically requires the input of a set of parameters that the software then employs to automatically screen out artifacts and take a measurement of particles based on segmentation of each image.  Thus, a fully automated approach can result in an entire image of particles sized in a matter of minutes, quickly yielding results that are consistent.  However, depending on the sample and the imaging conditions, this approach could omit particles that should be included, include artifacts that should not be included, and incorrectly identify particle boundaries because of subjective choices in the coding/script commands.     



In this SP, we present an approach using a combination of automated processing with manual screening, allowing for user evaluation of the particle boundaries and imaging artifacts (control) while still quickly automating many of the processing decisions into a ‘one click’ approach (efficiency and consistency).



3.3 Image requirements 

Images best-suited for processing in the manner detailed in section 4 have a high concentration of bright, non-overlapping particles that stand out well against a dark background.  Dark particles on a white background (as from a TEM image) are also acceptable.  Images unsuitable for analysis exhibit: significant overlap of particles, poorly-defined particle edges, substantial background features, low contrast, distortion due to charging effects, astigmatism, excessive noise, or low resolution. Extensive background features can be removed to some extent during processing; however, we recommend capturing the cleanest images possible to minimize the impact of processing.



For the most effective use of processing with Fiji and macros, it is important to ensure that all imaging conditions are constant.  In the authors opinion, once unsuitable images are screened out the most important variables to be kept constant are image size, pixel density, and beam conditions (e.g., current and voltage).  Keeping these variables constant ensures measurements all have the same error and limits with respect to the size range studied.



Lastly, the image analysis method in the following section is useful to generate particle size distributions for multiple specimens with which one can find relative changes.  If a true measure of the size is desired, a size calibration would be required using either a NIST or a commercial standard.  This calibration control would need to consider the background/substrate (e.g., textiles are highly rough in this case) employed for the actual sample to be relevant.



4 Using Fiji to Develop and Run Customized Macros for Image Processing and Particle Size Analysis



Macros are especially well-suited to speeding up repetitive processes in Fiji, and they can call predefined functions to implement a variety of different actions with just a few lines of user-written script.  Fiji also includes a Macro Recorder, which records user actions for easy creation of macros7.  Additionally, the Fiji Macro Language Programmer’s Guide is a resource for the Fiji scripting language7. Macros are saved as text files and added to Fiji in two ways: first, by installing the macro manually and, second, by adding the new script to the already existing Startup Macro.  An overall example of the macro used in this SP is available in Appendix A1 as well as much more detailed explanation of each individual step.  



1.1 Suggested processing to be included in a macro

There are many processing steps and other techniques that can be used to improve image quality and allow the software to better assess sizes automatically.  However, it is crucial that all steps used to process the raw images are recorded and the original raw images remain intact.  This way, there is not loss of information, sometimes referred to as metadata, that is included by the manufacturers software on the image file.  Some of the steps may be added to an image analysis scripts and some must be performed by the analyst.  These steps can be separated into categories including image organization, image processing, image segmentation, and particle analysis.



Image organization

· Create a working copy of the original raw images.  Store the original image set and perform all subsequent image processing on the working copy.  Sometimes it is ideal to create a new folder for the processed images

· The first step is to define the image size, both physically and the number of pixels so, that the particles observed can be measured well.  This is a step can easily be added into the script if one knows the horizontal field width (HFW), as is shown in Appendix A1.2.  

· Image cropping (Appendix A1.3) is necessary to remove the metadata (bottom Figure 2(a)), since the software does not differentiate among image pixels and text pixels.  A script can be modified to tune the cropping macro to one’s specific images.  NOTE:  Do not save over the raw data file after this point or you will lose the cropped metadata permanently.

Image processing

· Apply noise and several smoothing filters (Appendix A1.4).  This will help to eliminate artifacts such as pixel noise from being reported as individual particle events.

· Background subtraction can address noise that was not already corrected, as well as some other background unevenness such as edge effects that are present because of the substrate and not the particles.  This is automatically done in the script shown in Appendix A1.  The image in Figure 2(b) is a good example of how an image can be modified by following the steps to this point that we have outlined.Figure 2:  Demonstration of the evolution of the image during image processing.  (a) Original image saved from the microscope (b) Image after cropping out  metadata, scaling, noise removal and background subtraction (c) image after contrast adjustments and ready for thresholding to generate a mask, and (d) particles are identified that are consistent with the size and shape constraints that are set.



(a)

(b)

(c)

(d)



· The brightness and contrast adjustment is useful to maximize the dynamic range of pixel intensity on the greyscale (Figure 2(c)) for ease of viewing.  Pixels can have a range from 0 to 255.  In our script (Appendix A1.5), a dialog box automatically opens with the range adjusted. The process then automatically pauses until the user reviews, corrects and/or approves the dynamic range chosen.

Image segmentation

· Thresholding is one of the last steps and is used to segment the image and to make a binary mask with each pixel identified as either a 1 or a 0, particle or background.  A greyscale intensity cutoff is assigned to generate this binary mask which can be automatically determined by Fiji or determined by the analyst.  For our script, we have chosen to include user input by automatically thresholding but requiring approval or modification before proceeding (Appendix A1.5)8.

Particle analysis

· Circularity is a value used to screen the particles that would otherwise be counted for abnormal shapes and aggregates.  This is calculated for each particle automatically based on an adjusted ratio of the area: perimeter2 that is set between 0 and 1, with 1 being a perfect circle (Appendix A1.6).  User input is required to set the circularity in the script that we have written in Appendix 1.

· A size minimum allows the removal of noise that was not accounted for in earlier steps.  In our script, user input is required to set the size minimum.  

· Particles on the edge of the image should not be included because their size is unknown.  We have included this automatically in our script.

· The final step is to calculate the size of the particles.  Fiji defaults to area of the particle and provides a spreadsheet/table of areas for each particle based on specifications set in ‘Image organization’.  Additionally, a series of outlines are also provided in our script (See Figure 2(d)) which are representative of the particles provided in the spreadsheet that have met the user defined circularity and size requirements.  This outline is important to screen out non-particles (section 4.3).



The utility of this method, especially in scenarios with more than one specimen, will greatly depend upon the quality and consistency of the correction of the noise and segmentation of the image.  This is because small variations between images can result in large size changes, especially close to the lower limit of particle size determined by the minimum number of pixels required.  Figure 3 demonstrates variations due to the cutoff points when segmenting a small section of the image in Figure 2d.  It is apparent from Figure 3(A) that not all particles from the image (top) are analyzed for size which is indicated in the bottom image, a demonstration of the ability to screen out aggregates and small particles.  However, if one varies the threshold cutoff, the calculated particle diameter may change as well.  Figure 3(B) illustrates this by plotting the relative standard deviation (RSD) as a function of the average calculated particle diameter for a given particle at 7 consecutive thresholding values (>40 particles are present at all threshold values).  Unsurprisingly, the RSD increases more for smaller particle diameters since comparable changes in absolute pixel count has a relatively greater impact on smaller particles.Figure 3:  Impact of small changes in processing on average particle diameter.  (A) Small section (1 µm x 1 µm) of Figure 2 and representative mask of outline of pixels for acceptable particles.  (B) The impact of changing the threshold step on particle diameter by plotting the RSD as a function of average particle diameter with pixel boundaries by 7 different sequential set points.  

(A)

(B)

(a)

(b)

Figure 4: (a) Section of the image from Figure 2(a) prior to processing.  Arrows indicate adjoining particles which are included as single particles in (b) which represents the particle included with a 0.75 circularity minimum.





1.2 Sources of variability

The user should be aware that there are several points where measurement uncertainty can arise and work to minimize it.  As mentioned in the previous section, consistent criteria for assignment of the contrast and the threshold are essential to obtaining sizes across different images that can reliably be compared to one another.  Other sources of uncertainty are the HFW, or imaging size, and the pixel density set for the samples characterized.  Both relate to the minimum particle size based on the pixel limits set that can be resolved.  If images used are acquired under different HFWs or pixel densities, the results may be skewed to average particle diameters of a smaller value. 



1.3 User input to eliminate particles that are not screened out by the macro

While in an ideal case a one click/one command prompt would produce useable results from raw micrographs that have zero flows, it is not a realistic expectation.  The heterogeneous nature of the textile surface, requires different corrections in each image.  Furthermore, there is the possibility for adjoining particles (see Figure 4) and aggregates not to be screened out with the processing, so one must review and remove particles that are not reflective of the desired measurement.   It is essential that the criteria for removing a particle is kept consistent.



 

1.4 Calculating particle diameter and generating a histogram

Upon completion of the particle analysis in section 4.1, a spreadsheet including a list of particle areas are provided based on the size minimum and circularity limits set.  From this list, the user can calculate a diameter (d) based on the measured area (A) from the spreadsheet reflective of a circle of equivalent area, no matter what shape it appears on the micrograph using the following equation:Figure 5:  Histogram of particles in the image of Figure 2(a) after processing with the macro in Appendix A1.




 



Always double-check that Fiji has printed the results table in the units appropriate.  Figure 5 is a histogram representative of the distribution of particles from the image in Figure 2(c) using a 5-pixel radius minimum size and a value of 0.85 for the circularity.  The average particle diameter was 43.5 nm ± 13.9 nm.  Due to the low number of particles analyzed, this histogram is merely meant as a tool for illustration and not necessarily an accurate reflection of the sample.  It is important to note that with a 5-pixel minimum, there will be a 15.6 nm cutoff on particle diameter for the image size and pixel density.  For measurements of small-size particles represented by only a few pixels, higher resolution imaging may be required. 



5 Control to Check Particle Analysis Procedure:  RM 8017- 75 nm AgNPs



To demonstrate the effectiveness of the use of the approach in section 4 using Fiji, a control was devised using the 75 nm silver nanoparticle reference material (RM 8017) 1.  While this control does not include a substrate with comparable properties to the cotton fibers (e.g., roughness, charging), it does benefit from having known values for size attributed to the actual material that we are characterizing, which is important when assessing the technique for viability.  



5.1 Experimental details

RM 8017 was reconstituted in accordance to instructions in the certificate and drop-cast onto a Nanoplus TEM grid from Dune Scientific 1. Secondary electron micrographs were collected with an FEI Quanta 200 field-emission environmental scanning electron microscope (E-SEM) operating in high-vacuum mode, with a working distance of 10.2 mm, a spot size of 2.5 nm, and an accelerating voltage of 10 kV. Magnification was set to produce images with a horizontal field width of 3.20 µm and a horizontal resolution of 2048 pixels. 



Figure 6: (a) Representative images of RM 8017, nominally 75 nm silver nanoparticle reference material before image processing.  (b) Histogram of particle count vs. diameter over the range of particles measured and presented in Table 1.  A total of 290 particles were counted from 13 total images.

(a)

(b)



5.2 Image processing in Fiji

Micrographs acquired, such as the one shown in Figure 6(a), were subjected to processing in Fiji outlined in section 4.1 and further explained in appendix A1.

1. Crop: The data bar at the bottom of micrographs was removed.

2. Using the macros discussed in section 4.1, a rolling ball background subtraction was applied with a ball radius of 40 pixels, a smooth function was applied five times, and a despeckle function was applied once.

3.  In this case, the threshold was manually adjusted to ensure the whole particle was accounted for in the analysis.

4. Maps were created for visual inspection and false positives (aggregates and artifacts) were removed.

5. The resulting data is plotted in a histogram in Figure 6(b) and a list of values extracted from this processing are in Table 1.Table 1: Values and statistics from the particle size analysis in FIJI from images of RM 8017 silver nanoparticles based on 13 images.  For comparison, TEM reference values from the RM 8017 certificate are provided1.





Table 1 presents some of the results obtained from the measurements of this sample.  The top three values are likely the key pieces of information from the 13 images processed, segmented and analyzed.  The average and standard deviation allows for a rough comparison with the established TEM reference values. The 73.9 nm circular equivalent measurement result by the SEM, obtained from a much smaller number of particles, is indeed well within the error associated with TEM.  The reason why the uncertainty is higher for the SEM measurement is the small number of particles measured and that the TEM value represents the average and standard deviation of 9 separate vial of RM 8017 (the average or the averages).1 Regardless, while one could obtain better statistics by measuring more particles, this still provides another good demonstration on how high through-put processing using macros in Fiji can be employed to analyze particles from a set of images. 

6 Abbreviations



AgNP – Silver nanoparticles

e-SEM – Environmental SEM

Fiji – Fiji is just ImageJ

HFW – Horizontal Field Width

Nano-EHS – Environmental, health, and safety research as it pertains to nanomaterials

NIH – National Institute of Health

NIST – National Institute of Standards and Technology

NNI – National Nanotechnology Initiative

RM – Reference Material

RSD – Relative Standard Deviation

SEM - Scanning electron microscopy

TEM - Transmission electron microscopy

XPS – X-ray photoelectron spectroscopy
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Appendix A1

The text file available from https://doi.org/10.6028/nist.sp.1200-22s is an example of a macro used in this SP for demonstration purposes.  It is important to note that much of the choices made for image processing here shall be modified to fit the task at hand.





A1.1 Commenting the script and defining a macro

The authors consider it good practice to comment, or annotate, the script that one writes into the text file so future readers can understand what sections of the script are responsible for which actions.  For Fiji, addition of a line for a comment requires the addition of “//” symbols before the text describing the action.  This is required for each line.



Note that a script is started and finished using the following symbols: { and }, respectively.  Each macro is started by identifying the title of the macro and a hotkey associated with launching the macro once it is loaded into Fiji.  Macros can also be launched under the “Macros” in the “Plugins” menu.  



A1.2 Scale calibration

At some point during particle sizing, a user must calibrate the scale, so that the values associated with particles from the processed images can be converted from pixel areas to areas in square nanometers. A quick scale macro can be used to speed up the “set scale” process. This is shown in step 2 of our macro, which automatically calibrates the image with a user-input horizontal field width (HFW) and extracted horizontal pixel count.  Figure A1 shows the custom macro being used to calibrate an image to 3200 nm. For high accuracy work pertinent ISO or other traceable scale calibration methods shall be used. Figure A1:  Demonstration of how the information on the resolution line for an image should change when the scale is calibrated.





A1.3 Automatic cropping of images 

Electron micrographs will often have metadata printed at the bottom of the image. While this data bar is useful because it contains useful information, the data bar must be removed prior to particle analysis. A “crop” macro can be installed to speed up the process of removing the data bar, such as that seen in step 3 of the main text



The current script for the crop macro reduces the image to 2048 pixels * 1765 pixels (3200 nm x 2757.8 nm), removing the data bar from the bottom of the image as seen in Figure A2 (center).  While this macro is sufficient to remove the metadata that our SEM software attaches to the bottom of our images, this will vary from instrument to instrument. To find the correct size for your instrument, the authors recommend selecting the menu command “Plugins->Macros->Record…”, then selecting the desired area (without the data bar) using the rectangular area selection tool. The Recorder should display “makeRectangle(0, 0, x, y);”.  The user should use this line of script to replace/correct the first line in Step 3 and save the file for future use.  The crop function can also manually be performed under the “Image” menu of Fiji.



A1.4 Correcting noise, smoothing and background subtraction

Fiji has built-in tools to remove unevenness using a “rolling ball” background subtraction method with a ball radius of, for example, 40 px.  Additionally, Fiji has tools for removing salt and pepper noise called “Despeckling” and  edge jaggedness using a smoothing process5.  These tools can be used manually and are found under the “Process” menu.  Experimentation to determine the most appropriate set of settings is indispensable, as these vary case by case.



A1.5 Brightness/ contrast and thresholding 

To perform automatic particle analysis (to find particle size), a binary image is needed, in which each pixel is either black or white9. Set a threshold only after processing the image so that particles show clearly against the background.  Setting a threshold can be done manually.  To do so, select “Image->Adjust->Threshold…” (Ctrl+Shift+T). Drag the sliders until all particles are filled with red, out to their edges. Figure A2 shows an image that is actively where a threshold is about to be applied.  As can be observed, a grayscale histogram is displayed, and the user drags sliders to choose a threshold. Pixels shaded red will be converted to white (255), while pixels outside the red sections will be converted to black (0). This is a necessary step for particle analysis. For black particles on a white background, deselect the “Dark background” box.

A1.6  Analyzing particles

Fiji’s Analyze Particles function uses the binary image created in the last step to generate a list of particle areas. Select the menu command “Analyze->Analyze Particles…”

Analyze Particles has two important parameters:

Figure A2: Setting a Threshold by Hand





A1.6.1 Size

Size dictates the minimum particle size (area) that will be picked for analysis. A size no less than 78.5 pixel2 was used, dictated by the 2048 pixel image resolution. Size minimum and maximum can help in excluding artifacts, agglomerates and particles that differ in size from those particles of interest.



A1.6.2 Circularity

Circularity is calculated as  , where A is the area of the analyzed particle, and P its perimeter. A circularity value of 1 is a perfect circle. 



A1.6.3 Other settings

The Analyze Particles function calculates the area of a particle by counting the pixels inside a section defined by a threshold, then applies the user-defined scalar to convert the pixel measurement into a spatial measurement.

Tick both “Display results” and “Clear results”. This will print a list of particle areas and indices, and will clear and previous measurements. “Exclude on edges” is also recommended, as it excludes particles that are partially cut off by the edge of the micrograph. 



A1.6.4 Analysis results

Fiji will display a spreadsheet of values representative of particles in a micrograph that meet the circularity and size minimum requirements. It is recommended to save the spreadsheet either by copying it into a program such as Excel, or by saving it from the file menu as a text file. 
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